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Design Integration Using Autodesk Revit 2012

Lesson 7

Law Office: ROOF, FLOORS & CEILINGS:

Now that you have the floor plans developed to a point where only minor changes will
occur, you can start thinking about the horizontal planes within the building: roofs, floors
and ceilings.

In this text you will start with the roof. This is the first element most often modeled of the
three elements covered in this chapter. It is first because, with the roof in place, the exterior
of the building begins to take its final shape, specifically in 3D and camera views.

Floors and ceilings are then added so the building sections start to take shape. These
elements, plus a consultation with the mechanical engineer on the approximate size of the
ductwork, will help to determine the distance required between the floors and the roof.

The depth of the structural system is also an important factor when processing the
horizontal conditions of your building. This will be covered in the next chapter, but in reality
would be considered parallel with the information covered in this chapter via the structural
engineer.

Y. 9 <

Building section showing floors, ceilings and the roof; notice structural and ductwork as well.
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Introduction to the Roof Tool

In this lesson you will look at the various ways to use the Roof tool to draw the more
common roof forms used in architecture today.

Start a New Revit Project:

You will start a new project for this lesson so you can quickly compare the results of using
the Roof tool.

1. Start a new project using the default.rte template.

2. Switch to the North elevation view and rename the level named Leve/ 2 to T.O.
Masonry. This will be the reference point for your roof. Click Yes to rename
corresponding views automatically.

TIP: Just select the Level datum and click on the level

datums’s text to rename. T.O MaSC}nry’ e ;
- 10'- 0"

3. Switch to the Level 1floor plan view.

Drawing the Buildings:

- e ——

[ Coarse

4. Set the Level 1 “Detail I evel” to Medium, so the
material hatching is visible within the walls.

T1P: Use the VView Control Bar at the bottom.

5. Using the Wall tool with the wall Type set to
“Exterior - Brick on Mtl. Stud,” draw a
40'-0" x 20’-0" building (Figure 7-1.1).

FYT: The defanit Wall height is OK; it should be 200"
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Law Office: ROOF, FLOORS & CEILINGS

Be sure to draw the building g
within the elevation tags.

TIP: You can draw the building
in one step if you use the
Rectangle option on the Ribbon,
while using the Wall tool.

Elevations tags — (4) are shown which

correspond to the (4) elevation views
listed in the Project Browser. \
)

FIGURE 7-1.1 Bldg. and Elev. tags

You will copy the building so that you have a total four buildings. You will draw a different
type of roof on each one.

6. Drag a window around the walls to select them. Then use the Array command to set
up four buildings 35'-0" O.C. (Figure 7-1.2). See the ARRAY TIP below.

TIP: Zoom in and make sure g
the brick is on the excterior side

of the wall. If not, you can

select each wall and click its

tlip zcon.

ARRAY TIP: Select the first
building; select Array. Just
like the Copy command,
define a copy 35 to the right,
then enter the number of copies.

£

FIGURE 7-1.2 Four buildings

7. Select all of the buildings and click Ungroup [@

trom the Ribbon. Ungroup
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Hip Roof:
The various roof forms are largely defined by the Defines slope setting. F
This is displayed in the Options Bar while the Roof tool is active. When a =
wall is selected and the Defines slope option is selected, the roof above .
that portion of wall slopes. You will see this more clearly in the examples F Roof by Footprint
below.
&_L Roof b ion
8. Switch to the T.O. Masonry floor plan view. @ Roof by Facy
9. Select the Home => Build = Roof (down-arrow) > Roof by N\ Roof soffit
Footprint tool. v :
Fascia
10. Set the overhang to 2'-0" and make sure Defines slope is Y Gutter
selected (checked) on the Op#ons Bar.
Defines slope | Owverhang: 2' 0" Extend to wall core ‘
11. Select the four walls of the West building, clicking each
wall one at a time. =
TIP: Make sure you select towards the exterior side of the wall; notice the
review line before clicking.
[N
12. Click Finish Edit Mode (i.c., the green check mark) on &5
the Rzbbon to finish the Roof tool. He @2
13. Click Yes to attach the roof to the walls.
14. Switch to the South elevation (Figure 7-1.3).

- A [ _ _ _ _ T.0. Masonry_
. . B G

FIGURE 7-1.3 South elevation — Hip roof

Ls 11,
P "]

You will notice that the default wall height is much higher than what we ultimately want.
However, when the roof is drawn at the correct elevation and you attach the walls to the
roof, the walls automatically adjust to stop under the roof object. Additionally, if the roof is
raised or lowered later, the walls will follow; you can try this in the South elevation view by
simply using the Move tool. REMEMBER: Y ou can make revisions in any view.
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Law Office: ROOF, FLOORS & CEILINGS

15.

Switch to the 3D view using the icon on the QAT (Figure 7-1.4).

S

You can change the “model graphics ’ i

style” to Shading with Edges if you
would like. Select the V7sual Style
icon on the Izew Control Bar at the

bottom.
FIGURE 7-1.4 3D view — hip roof
Gable Roof:
16. Switch back to the T.O. Masonry view (not the ceiling plan for this level).

17.

18.

19.

20.

21.

22.

23.

24,

Select the Roof tool, and then Roof by Footprint.

Set the overhang to 2'-0" and make sure Defines slope is selected (checked) on the
Options Bar.

Only select the two long (40'-0") walls.

Uncheck the Defines slope option.

Select the remaining two walls (Figure 7-1.5). w
Pick the green check mark on the Rzbbon to finish the roof. Qf
Select Yes to attach the walls to the roof. | Mode |

Switch to the South elevation view (Figure 7-1.6).
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&

FIGURE 7-1.5 Gable — plan view

N

FIGURE 7-1.6 South elevation — gable roof

25. Switch to the 3D view (Figure 7-1.7).

Notice the wall extends up to conform to the underside of the roof on the gable ends.

FYT: You may be wondering why the roofs look odd in the floor plan view. If you remember, each
view has its own cut plane. The cut plane happens to be lower than the highest part of the roof —
thus, the roof is shown cut at the cut plane. If you go to Properties Palette = 1 iew Range (while
nothing is selected) and then adjust the cut plane to be bigher than the highest point of the roof; then
you will see the ridge line.
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>

FIGURE 7-1.7 3D view — gable roof

Shed Roof:
26. Switch back to the T.O. Masonry view.

27. Select the Roof tool, and then Roof by Footprint.

28. Check Defines slope on the Options Bar. ?:1252:01 \
29. Set the overhang to 2'-0" on the Options Bar. 1
30. Select the East wall (40'-0" wall, right-hand side). Jl
31. Uncheck Defines slope in the Options Bar. (jifrnot\r;l /

32. Select the remaining three walls (Figure 7-1.8).

FIGURE 7-1.8 Selected walls
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(S e e e e

. . Properties [=]
33. Set the Slope, or roof pitch, to 3/12 (Figure 7-1.9)
on the Properties Palette. -
34. Click Apply on the Properties Palette. Roofs ) 5 it Type
Constraints Gl -
Base Level Level 2
35. Pick the green check mark on the Ribbon to finish froom Bounding
Related to Mass O
the tOOf. Base Offset From L.. 10" 0" L
Cutoff Level None B
Cutoff Offset [
36. Select Yes to attach the walls to the roof. Construction
Rafter Cut Plumb Cut
Fascia Depth oo
ﬁ Maximum Ridge . (0 0 P
Dimensions A
Would you like to attach the highlighted walls to i:ﬁ::ness j {)12
the roof? Volume v
Properties help Apply
e ] [ o FIGURE 7-1.9
Properties for Roof tool

FYI: You can also change the slope of the roof by changing the Slope Control text (see Figure 7-
1.8); just select the text and type a new number.

TIP: You can use the control arrows, while the roof line is still selected, to flip the orientation of
the roof overhang if you accidentally selected the wrong side of the wall and the overbang is on the
inside of the building.

37. Switch to the South elevation view (Figure 7-1.10).

ﬁilﬁﬁmge
. - - - - - e

FIGURE 7-1.10 South elevation — shed roof
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38. Switch to the Default 3D view (Figure 7-1.11).

%

FIGURE 7-1.11 Default 3D view — shed roof

Once the roof is drawn, you can easily change the roof’s overhang. You will try this on the
shed roof. You will also make the roof slope in the opposite direction.

39. In T.O. Masonry view, select Modify from the Rzbbon, and then select the shed

roof.
40. Click Edit Footprint from the Ribbon. o
Edit
41. Click on the East roof sketch-line to select it. Footprint

42. Uncheck Defines slope from the Options Bar.

43. Now select the West roofline and check Defines slope.
If you were to select the green check mark now, the shed roof would be sloping in the
opposite direction. But, before you do that, you will adjust the roof overhang at the high

side.

44. Click on the East roofline again, to select it.
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45. Change the overhang to 6’-0" in the Options Bar.
Changing the overhang only affects the selected roofline.
46. Select the green check mark.
47. Switch to the South view to see the change (Figure 7-1.12).

Thus you can see it is easier to edit an object than to delete it and
start over. Just remember, you have to be in sketch mode (i.e., Edit

Sketch) to make changes to the roof. Also, when a sketch line is FIGURE 7-1.12 South
selected, its properties are displayed in the Properties Palette. That elevation — shed roof
concludes the shed roof example. (revised)

Flat Roof:

48. Switch back to the T.O. Masonry floor plan view.

49. Select Home = Roof = Roof by Footprint.

50. Set the overhang to 2-0" and make sure Defines slope is not selected (i.e., un-
checked) in the Options Bar.

51. Select all four walls.
52. Pick the green check mark.

53. Select Yes to attach the walls to the roof.

ﬁiimw?s
-- -—- -—- -— Sl &
FIGURE 7-1.13 South elevation — flat roof

54. Switch to the South elevation view (Figure 7-1.13).
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55. Also, take a look the Default 3D view (Figure 7-1.14).

T/
o

FIGURE 7-1.14 Default 3D view — flat roof

56. Save your project as ex7-1.rvt.

Want More?

Revit has additional tools and techniques available for creating more complex roof forms.
However, that is beyond the scope of this book. If you want to learn more about roofs, or
anything else, take a look at one of the following resources:

e Revit Web Site (www.autodesk.com)
e Revit Newsgroup (potential answers to specific questions)
www.augi.com; www.revitcity.com; www.autodesk.com; www.revitforum.org

e Revit Blogs information from individuals (some wotk for Autodesk and some don’t)
www.revitoped.com, insidethefactory.typepad.com
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Reference material: Roof position relative to Wall

The remaining pages in this chapter are for reference only and do not need to be done to
your model. You are encouraged to study this information so you become more familiar
with how the Roof tool works.

The following examples use a brick and concrete wall example. The image below shows the
Structure properties for said wall type. Notice the only item within the Core Boundary section is
the Masonry — Concrete Block (i.e., CMU) which is 7%" thick (nominally 8"). Keep this in mind
as you read through the remaining material.

Edit Assembly (=]
Family: Basic Wall
Type: Exterior - Brick on CMU
Total thickness: 1 712" Sample Height: 20 0]
Layers
EXTERIOR. SIDE

Function Material =
b Finich 1 [4] Masonry - Bric U
2| Thermal/fir L | Misc. Air Layer (0
3 | Thermal/AirL i Insulation/Th 0
4 [Membranela :Vapor/Moist 0
5 | Core Boundary : Layers Above W: 0" 0"
6 | Structure [1] Masonry - Co 0" 75/8"
7 | Core y | Layers Below W 0° 0"
8 | Substrate [2] Metal - Furrin 0" 15/8 il

=
B
2
u
=)

E
[ Insert ] [ Delete ] Up

Default Wrapping
At Inserts: At Ends:
[Do not wrap - ] [None v]

Modify Vertical Structure (Section Preview only)

Modify Merge Regions Sweeps
Assign Layers Split Region Reveals
<< Preview I [ CK ] [ Cancel ] [ Help

The following examples will show you how to control the position of the roof system
relative to the wall below, both vertically and horizontally. The roof properties that dictate its
position basically involve relationships between three things: the Level Datum, the exterior
Wall System and the bottom edge of the Roof System. There are several other properties
(e.g., pitch, construction, fascia, etc.) related to the roof that will not be mentioned at the
moment so the reader may focus on a few basic principles.



Law Office: ROOF, FLOORS & CEILINGS

The examples on this page show a sloped roof sketched with Extend into wall (to core) enabled

and the Overhang set to 2'-0". Because Extend into wall (to core) was selected, the bottom edge
of the roof is positioned relative to the Core Boundary of the exterior wall rather than the
tinished face of the wall. See the discussion about the wall’s Core Boundary on the previous

page.

_ Level 2
0.0

_lLevel2
10-0"

X

%

Ref
Point

o
5

2ok
heleS

Ref
Point

SI000590050%
00558

< KK KA
0.

3
5
<5

S

25
%5
25

<
00888
5

A I A

<

Wall
Core

Wall
Core

Extend to Core + Rafter Extend to Core + Truss

Revit Roof Properties under Consideration:

Extend Into Wall:

(To Core)

Rafter or Truss:

Base Level:

Base Offset:
From Level

This option was checked on the Options Bar while sketching the roof.

This option is an Instance Parameter of the roof object; the example on
the above left is set to Raffer and the other is set to Truss.

INOTE: The Extend into Wall (to core) option affects the relative
relationship between the wall and the roof, as you will see by comparing this
excample with the one on the next page.

Set to Leve/ 2: By associating various objects to a level, it is possible
to adjust the floor elevation (i.e., Leve/ Datum) and have doors,
windows, floors, furniture, roofs, etc., all move vertically with that
level.

Set to 0-0” This can be a positive or negative number which will be
maintained even if the level moves.
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The examples on this page show a sloped roof sketched with Extend into wall (to core) NOT

enabled and the Overbang set to 2'-0". Notice that the roof overhang is derived from the
exterior face of the wall (compared to the Core Boundary face on the previous example when
Exctend into wall was enabled).

_ _Level 2
P
,45
A Ref . Level 2
. Point - n T {0 -0"
ES &
. H Ref
[ . Point
:: Wall .
Core
Wall
Core
Rafter + not extended to core Truss + not extended to core

Revit Roof Properties under Consideration:

Extend into Wall:
(To Core)

Rafter or Truss:

Base Level:

Base Offset:
From Level

This option was NOT checked on the Options Bar while sketching the

roof.

This option is an Instance Parameter of the roof object; the
example on the above left is set to Raffer and the other is set
to Truss.

INOTE: The Extend into wall (to core) option affects the relative
relationship between the wall and the roof, as you will see by comparing this
example with the one on the previous page.

Set to Leve/ 2. By associating various objects to a level, it is possible
to adjust the floor elevation (i.e., Leve/ Datum) and have doors,
windows, floors, furniture, roofs, etc., all move vertically with that
level.

Set to 0-0”. This can be a positive or negative number which will be
maintained even if the level moves.
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Defines slope Overhang: 2' 0" Extend to wall core

As you can see from the previous examples, you would most often want to have Extend o
wall (to core) selected while sketching a roof because it would not typically make sense to
position the roof based on the outside face of brick or the inside face of gypsum board, for
commercial construction.

Even though you may prefer to have Extend to
wall (to core) selected, you might like to have a

[ Edit Assembly ==

Family: Basic Wall
2'-0" overhang relative to the face of the brick e erior -Brckon G

. Total thidmess: 1 717" Sample Height:
rather than the exterior face of concrete
block. This can be accomplished in one of
two ways:

EXTERICR SIDE

F v - Bric
2| Thermal/air L isc. Air Layer

(A)  You can modify the overhang, while Thermal/Air | Tnsulation / Th
sketching the roof, to include the Mok M i M
wall thickness that occuts between T
the face of wall and face of core: 8 |Substrate[2] | Metal -Furrin 0" 15/8" i
2!_0" + 95/8" — 2’—95/8". See the INTERIOR. SIDE
. . [ st ][ o= || o [ b ]
image to the right.

Default Wrapping

At Inserts: At Ende:
(B) The second option is to manually EFEEES 7] [none 7
edlt the sketch ]ineS. YOu can add Modify Vertical Structure (Section Preview only)

| Modify | | Merge Regions Sweeps |

dimensions while in Sk&esch mode,

select the sketch line to move, and
then edit the dimension. The [ssprevien | [ ¢ J[ cod [ ren |
dimension can also be Locked to

| |
| Assign Layers | | Split Region | | Reveals |

maintain the roof edge position
relative to the wall. When you finish
the sketch the dimensions are

hidden.

Energy Truss:

In addition to controlling the roof overhang, you might also want to control the roof
properties to accommodate an energy truss with what is called an energy heal, which allows for
more insulation to occur directly above the exterior wall).

To do this you would use the Extend into wall (to core) + Truss option described above and

then set the Base Offset from Level to 1'-0" (for a 1'-0" energy heal). See the image and the
Properties Palette shown on the next page.
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o _ Level 2
10-0"
2'-95/8" ]
1
Wall
Core
Properties (=]
[ Pl -l Many other properties and techniques exist which one
eneric - 12 . .
can use to develop the roof for a project, things like
Roofs ~ | B Edit T, . : :
foon ) JE8 EdtTee | the Rafter Cut and Fascia Depth which control the fascia
onstraints Aoa .
Base Level Roof | design. Also, you can apply a sweep to a roof edge to
oo Soung - add a 1x fascia board around the building. These are
Base Offsct Eram Level 11 0 ) intermediate to advanced concepts and will not be
Cutoff Level Mone d h
it Gfect g covered nete.
Construction -3
Rafter Cut Plumb Cut .
Facis Bepth G This concludes the study of the Roof tool!
Rafter or Truss Truss -
Maximum Ridge Height {34' 713/16" 1
Dimensions -3
Slope 9" /12"
Thickness 10"
Volume 5848.30 CF
Area 5848.30 5F
Identity Data H
Comments
Mark
Phasing A L
Phase Created { New Construction :
Phase Demolished : None |
Properties help Apply
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Law Office Roof

The template file you started with already has a Roof plan view created. However, you
renamed that to Level 2 and then created a new Rogf datum and corresponding views. If you
recall, the Roof datum is at 26'-8" (see page 6-34). This Roof plan view creates a working
plane for the Roof tool; the thickness of your roof sits on top of the reference plane.

Create a Flat Roof:
1. Open your Law Office BIM file.
2. Switch to the Roof plan view.

Your image should look something like Figure 7-2.1. The exterior walls you can see in the
Roof plan view were created in Lesson 6; the specified height extends into the Roof’s zew
Range. The interior walls and stairs are visible, but are shaded gray (i.e., halftone); this is
because of a view setting called Underlay. The Underlay feature is used to visually
coordinate items between floors. In the roof plan you might want to know where the wall
between the two toilet rooms is to discern where the vent pipe will penetrate the roof.

You will be selecting the exterior walls to define the edge of the roof. Before you can finish a
roof sketch, you must have the entire perimeter of the roof drawn with line endpoints
connected. Revit allows you to sketch additional lines and use tools like Tz to complete the
perimeter of the roof sketch if needed.

3. Select the Rooftool from the Home tab; click the down-arrow.

4. Select Roof by Footprint from the pop-up menu.

5. Make sure Pick Walls is selected Réibbon: Home = Draw (panel).

Aurndesk Rewir Architeeture 2012 Nor For Resale Versinn | aw Office Chaprel

EHOG-KR-7- 270 A G-

Madity | Create Koot Fanfpnnt

= #, Cope - (] — < w =
i ; =1 Bit=3 K o] 12
Madify | Ll Paste _ - ‘_‘D"* ] (ﬁ-. . J.: [-f;_?" Slope Arrow "‘: '/,_: (‘ r ﬁv N
5 M Join = & + 4 W = @ ,f[x{lﬁ =
Select | Properties | Clipboard Geometry Measure Create Maode Draw

Defines slope | Overhang: 0' 0" Extend to wall core

$
1 :
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FIGURE 7-2.1 Roof Plan; initial view

6. Uncheck Defines Slope on the
Options Bar to make a flat roof.

Change the drop-down selector, on
the Properties Palette, to New
<Sketch> (Figure 7-2.2).

These are the properties for the sketch
lines, not the roof element (compare Roof
Instance Properties).

8. Notice if this were a sloped roof,
you could change the roof pitch

here.

9. Change the drop-down back to
Roof so you can see the roof
element properties.

10. Check Extend to wall core on the

Options Bar.
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FIGURE 7-2.2 Roof Properties

I g&l [7 K| F cope - [2 &)
i P W@
HLut v =
Modify | [[H]| | Paste |- o
5] - Bl Hein - £
Select | Properties | Clipboard Geometry
[7] Defines slope | Owerhang: 0' 0" [¥] Extend to w.
Properties E]|
New <Sketch> »| Az Edit Type
Constraints ]
Defines Roof Slope
Offset From Roof Base ;0" 0"
Dimensions ]
Slope gy
e e g M A g -
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We will digress for a moment to explain exactly what “extend to wall core” means. This will
help ensure you create the roof correctly. First the properties of the wall will be exposed so
you understand what constitutes a wall type core. Next, you will learn how this ties into the
Roof tool. If you want to follow along, you can select Cance/ Roof on the Rzbbon and then
repeat the previous steps before moving on to the next numbered steps.

Back on page 6-18 and following you explored the exterior wall style. There it pointed out
where to view/edit the “structure” of the wall Layers, via the Edit Assenbly dialog. The
graphic below shows a variety of wall types with their wall cores highlighted. Within the Edz#
Assembly dialog, the highlighted Layer(s) fall within the Core Boundary section.

Generally speaking, the Wal/ Core represents the real-world structural portion of the wall.
Walls can be both drawn and dimensioned based on the faces and centetline of the wall
core. The Wall Core has a higher precedence when walls intersect. Revit automatically cleans
up similar Layers within other wall types. Additionally, in the case of this exercise, the wall
core is used in conjunction with creating the roof element. This is also true for floors as well.

Stud wall Stud furring Masonty cavity wall CMU wall

Notice a few things about the walls above before moving on. The two walls on the left have
the metal stud Layer within the Wal/ Core, but the masonry cavity wall does not. In the first
two, the studs are the structural element holding up the wall, in the latter the CMU holds up
the wall and the metal studs are just used to fasten the gypsum board to it. Finally, the fourth
wall contains one Layer which is the Wall Core. Every wall must have at least one Layer within
the Core Boundary. An example of two Layers within the Core Boundary might be the studs and
the sheathing which is used for shear; making both Layers part of the structural makeup of
the wall. In this case you would never want any intersecting wall to interrupt the sheathing.

When using the Rogf tool, it is possible to have Revit automatically sketch the roof’s edge
based on one of the two faces of a Wa// Core. Therefore, it is important to select towards the
side of the wall relating to the core face you want. The two images below show the two
options possible when Extend wall to core is selected within the Roof tool.
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wall wall
core boundary core boundary

| | ! |
S le o e e
sa le T [l

Roof AR R Roof
Roof 26 . 8"

Roof tool: Exctend to core options

Notice in both images above, the gypsum board Layer within the wall type is interrupted by
the roof. You will employ the option on the left. However, either option is perfectly valid
depending on how the building is intended to be constructed: a separate parapet or balloon
framing.

In either case, due to the use of metal studs, the roof deck will be supported by steel beams
at the perimeter. The structural system will be added in the next chapter. Revit does not care
if a roof or floor is not properly supported, which is not the case with beams, as you will see
in the upcoming structural section.

11. Select each of the exterior walls, favoring the exterior side when clicking the wall.
Just before clicking, the dashed reference line should be at the exterior face of the
wall core per the example shown in Figure 7-2.3.

T1P: Use the flip control zeon while the line is still selected if your dashed reference line is on the
wrong side (.., interior).
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L3 k]

----- - - o o o oW o - T o -
- r =

Correct

\ : Not correct

FIGURE 7-2.3 Roof Plan; four walls selected for sketching roof footprint

Note that the exterior walls, just selected, can be selected in any order.

All of the sketch lines should have automatically trimmed at the corners (Figure 7-2.4). If
not, you would need to use the T7 tool to close the perimeter of the roof footprint. Many

of your 2D drafting skills learned eatlier in this book can be applied to this type of Skezh
mode.

FIGURE 7-2.4
Roof sketch lines at perimeter of building
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Take a moment and look at the Properties Palette. As already mentioned, the overall roof
thickness sits on top of the Leve/ datum of the view in which it was drawn. Typically, the Roof
Level datum relates to the top of the steel beams, thus the roof occurs above that elevation.

Notice the parameter Base Offset From Level. This allows you to enter a distance in which to
move the roof up from the Base Level. If you entered 2'-0" and the roof level datum changed,
the roof would still be 2'-0" above the repositioned level datum.

Before completing the roof you will learn how to specify the Roof Type. This is similar to
walls in that various Layers can be defined within the roof element.

12. Select Edit Type button on the Properties Palette notice the various Parameters and
Types available; click OK to close without making any changes.

i Y
Type Properties u . A .
Notice in Figure 7-2.5 that the Type
Family: [Svshem Family: Basic Roof '] Load... drop—down at the tOp ljStS ﬁVC I'OOf
Type: [insulation on Metal Deck - EPDM [ Duplicate. .. ] types.
Generic - 97
Generic - 127
G ic - 12" - Filled :
Type Paramet Generic - 18 13. Make sute the Type Selector is
set to Insulation on Metal
Construction Deck — EPDM on the
Structure i Edit... ] .
Defauit Thickness 0734 Properties Palette.
Graphics _ 2
Coarse Scale il Pattern i Now that the roof footprint is
Coarse Scale Fill Color i_!BIack [ .
Jdentity Data 5 complete you can finish the roof.
Keynote
Maodel e s
e 14. Select Finish Roof from the
anufacturer R
Type Comments Ribbon.
URL
Description .
Assembly Description Roof Construction 15. Cth No to attach WQ_HS
Assembly Code B1020 : _
T Uik (Figure 7-2.6).
Cost
’ << Preview ] [ 0K ] ’ Cancel ] Apply

FIGURE 7-2.5 Roof type properties; selecting roof type

[ Revit =X
Would you like to attach the highlighted walls to
the roof?

FIGURE 7-2.6 Roof Plan; attachment warning
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16. Click Yes to join the roof and exterior walls.

Revit

Joining the roof and walls via this
prompt is what interrupts the stud

Layer as shown in the graphic on page
7-20.

The floor/roof overlaps the highlighted wall(s).
Would you like to join geometry and cut the
overlapping volume out of the wall(s)?

FIGURE 7-2.7 Roof Plan; join and cut prompt

17. Switch to your 3D view via the Quick Access Toolbar.

Your project should look like Figure 7-2.8.

FIGURE 7-2.8 3D View; roof added
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[propetes @ 18. Switch back to your Roof floor plan

view.

Despite the fact that you just added a roof, which
is a solid 3D element, you can still see the second

Floor Plan: Roof - Edit Type ) .

- l & floor walls. When the Underlay feature is set, it
Graphics P . .
View Scale 14" = 1'-0" —| will show the selected level on top of whatever is
Scale Value 1t 4 visible in the current view. At this point we don’t
Display Model Mormal want to see the Level 2 walls anymore.

Detail Level Coarse
Visibility/Graphics O... { L 19. Make sure nothing is selected so the
Visual Style Hidden - . . . .
o . — View Properties are showing in the
Graphic Display Opti... )
Underlay Properties Palette.
Underlay Orientation : Plan
Orientation Project North 20. Set the Underlay Parameter to None
Wall Join Display Clean all wall joins - (Flgure 7.0 9)
Discipline Architectural e
Color S5cheme Locati...; Background . .
P P [ prr— 21. Click Apply to make the adjustment to
Analysis Display Style | None the view.
Sun Path
e A The Leve/ 2 walls are now removed from the
View flame Roof Roof plan view
Dependency Independent - p ’

Properties help Apply

FIGURE 7-2.9 Roof plan view; view propertied

At some point in the project you would edit the roof surface to have the required sloped
surfaces to shed rain water towards the roof drains. But those types of edits are best saved
for later in the design process. If you spent the time to model that information now and then
the client decided to make a big change, you would have to redo all that work.

22. Save your project.

TIP: You have probably figured this out by now: the last view open when you close the project will
be the view that is opened the next time the project is opened.
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Floor Systems

In this exercise you will add the Level 1 and Level 2 floors. The Level 1 floor is a slab-on-
grade example, as the building has no basement, and Level 2 is a composite concrete and
metal deck floor. Both of these floors are already defined in the project, which stems from
the template from which it was started.

Level 1, Slab on Grade:

Sketching floors is a lot like sketching roofs; you can select walls to define the perimeter and
draw lines to fill in the blanks and add holes, or cut outs, in the floor object.

1. Open your Revit project (Law Office). '-

Floor

-

2. Switch to the Level 1 floor plan view if needed.

3. Select Home = Build - Floor (down-arrow) = Floor.

ﬁ— 4. Click the Type Selector on the

Properties Palette.

Floor

4" Concrete Slab 5. Set the Type to 4" Concrete Slab

(if not already); see Figure 7-3.1.

Floor

6. Click Apply to accept the

change.
Notice, in the Properties Palette, the Height

Freerd 3 LW Concrete on 2" Metal Deck

|‘=u'.1" Concrete Slab %‘% ‘

=" Cancrete Slab w VCT

Offset From Level which allows the slab to
be moved up or down relative to the
I evel that hosts the slab.

[ Generic - 12° Also, the Phase Created allows you to

manage which portion of the building is
existing and new. The law office project
is all new, so you do not have to worry
about any Phase settings.

[ Generic - 12 - Filled

== W Concrete on Metal Deck

FIGURE 7-3.1 Floor tool; type selector
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Similar to the Roof Sketch mode, you will be drawing the Bowundary Line for the floor by
picking walls. Ultimately your slab will stop at the foundation walls, but they have not been
drawn yet so you will draw the slab to the interior face of core. Remember, for the roof you
went to the exterior face of core.
7. Make sure the Rzbbon and Options Bar match the settings shown in Figure 7-3.2.
a.  Boundary Line selected (Draw panel)
b. Pick Walls icon selected (Draw panel)

c. Extend into wall (to core) checked (Options Bar)

x |IL Boundar}rLlne|/D’{_}f_‘§® @ ﬁ F

@ Slope Arrow “r {-+ ' Set Show Ref
[ Span Direction & 2 ./[{. z Plane
I Mode | Draw | Work Plane

Offset: 0" 0" Extend into wall (to core)

FIGURE 7-3.2 Floor tool; ribbon and options bar settings

8. Select the interior side of each exterior wall, with the exception of the curtain wall
(do not select it yet). See Figure 7-3.3.

FIGURE 7-3.3
Floor tool; boundary lines sketched

7-26



Law Office: ROOF, FLOORS & CEILINGS

You will select the curtain wall in 2 moment. However, it is a different thickness and does
not have a core like the other walls. So, when you pick the wall, the floor boundary sketch
line will be centered on the curtain wall. You will have to manually sketch lines and trim
them at each end of the curtain wall in order to properly enclose the floor boundary.

9. Select the curtain wall, which in turn adds a curved boundary line.

10. Zoom in to each end of the curtain wall, and select the Line

icon from the Draw panel on the Create Floor Boundary tab. S @ O -
roCOs,
11. Sketch a line, using snaps, from the end of the arc to the & D ,ﬁ ﬁ =

adjacent wall sketch line (Figure 7-3.4).

12. Use the Trim tool, while still in the Floor Sketch mode, to clean up any corners that

are not perfect. This is likely only going to be at the transition from the curved wall
to the orthogonal walls.

FIGURE 7-3.4

Floor tool; boundary lines sketched
at curved curtain wall area

Now that you have the perimeter of the floor defined, you may finish the creation of the
floor element.

13. Click the green check mark on the Ribbon to finish the floor.

TIP: If you get any errors, see the next page.
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COMMON ERRORS FINISHING A FLOOR SKETCH:

If you get an error message when trying to finish a floor sketch, it is probably due to a
problem with the sketched perimeter lines. Here are two common problems:

Perimeter not closed:
You cannot finish a floor if there is a gap, large or small, in the perimeter sketch.
Fix: Sketch a line to close the loop.

lf’ 27 Sketch lines —
S e T s perimeter not closed

@

R . because line is missing

4 N Autodesk Rewit Architecture 2012
- Error - @nnotbeignored
Lines must be in desed loops. The hignlichted Ines are coen o1 one end. -
a
I -
N v . B
& L2 T [ swow || voerto | [ Epmdss ]
. . A :
.

Error message after clicking finish sketch

Perimeter lines intersect:
You cannot finish a floor if any of the sketch lines intersect.
Fix: Use Trim to make it so all line endpoints touch.

4
-
= = e p Sketch lines — lines
- . B N . . o7 co- . .
o ) - Cota

extend past each
other; not good

-
Autndesk Revit Architecture 2012
Error - cannot be ignored
N Lines cannot intersect each other. The highlighted lines currently intersect. &
L —
& ) o
.o T 4 -
- & . B
N - - “ o =1
e [ Show ] | More Info | Exoand >3 ]
Quit sketching ( Continue ]

Error message after clicking finish sketch
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The floor for Level 1 has now been created. However, because it has no surface pattern
assigned to it, you cannot really see it. The only place it is visible is at the two exterior door
openings (Figure 7-3.5); this is the best place to select the slab by pressing Tab to get past
the door and select the slab.

RS

i q

J

FIGURE 7-3.5 Level 1 floor plan; floor slab visible at exterior door openings

Often a surface pattern is not assigned to the structural slab. Instead, another floor is added
in each room to define floor finishes later during the design process once the plan is fixed. A
4" thick Floor can be created for each floor finish. The 4" Flooris then added to each room,
offset /8" from the host level so it is on top of the structural slab. This method allows
various surface patterns to be applied. If a surface pattern were added to the structural slab,
it would be visible everywhere, such as toilet rooms, the lobby, and the mechanical room.
The other benefit is the ability to schedule the floor finishes and get quantities. You can even
add formulas to the schedules and get total cost for each flooring type!

Level 2, Slab on Grade:

Creating the second and third floors will be a little more involved than the first floor. This is
because the upper floors require several openings. For example, you need to define the
openings for the stair shaft and the two-story lobby space. However, Revit makes the
process very simple.

You will again use a predefined floor type for the Level 2 floor. The floor you will use is 52"
thick: a 172" metal deck and the remaining is concrete. At this eatly stage in the project it
may be helpful to modify the floor to have a Layer that represents a placeholder for the
structural joists that hold up the floor. In section view, this can help better visualize the
required space, before the structural engineers add their elements to the BIM.
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14. Switch to the Level 2 floor plan view.
15. Click to start the Floor tool on the Ribbon.
16. Click Edit Type on the Properties Palette.
17. Set the Type to LW Concrete on Metal Deck.
18. Click Edit, next to the S#ucture parameter.
You are now in the Edit Assembly dialog; here you will temporarily add a Layer to serve as a

placeholder for the bar joists (Figure 7-3.6). This process is identical for editing Revit walls
and roofs!

g
Edit Assembly -

Family: Floor
Type: LW Conaete on Metal Dedk
Total thickness: 0" 5127 (Default)

Layers

Function Material Thickness | Wraps »
Core Boundary ; Layers Al Wrap 0" 0
Structure [1] Concrete - Cast-in-Pla o' 4" [ ]

Structure [1] Metal - Deck
dary i Bl WAl

] pa| =

FIGURE 7-3.6 Edit assembly dialog for current floor type.

19. Click the Insert button.
The new Layer should have been placed below the bottom Core Boundary placeholder. This is

fine for what we are attempting to do. You will also set the Function to “finish” so the walls
are not adversely affected by this temporary element in the floor type.
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20. Change the new Layer as follows (Figure 7-3.7):
a.  Function: Finish 2 [5]
b. Material: <By Category>
c.  Thickness: 1'-2"

Function Material Thickness | Wraps| Variable| =
1 | Core Boundary Layers Above 0° 0 L4
2 | Structure [1] Concrete - C 04" =l
3 | Structure [1] Metal - Deck 0" 11/2" =l
4 | Core Boundary: Layers Below 0" 0"
5 | Finish 2 [5] <By Categor (1" 2" [

FIGURE 7-3.7 Floor properties: layer settings

21. Close the open dialog boxes (i.e., click OK two times).
You are now ready to start sketching the boundary of the Level 2 floor.

22. Using the Pick Wall icon, select the walls shown in Figure 7-3.8:
a. Make sure Extend into wall (to core) is selected.

b. Click to the exterior side of the exterior walls, opposite to what you did for

Level 1.
a4
3
2
A
1
L
5
AT
8
7
FIGURE 7-3.8
Level 2: Eight floor boundary lines sketched | 6 |
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23. Zoom into the North stair, and make the edits shown in Figure 7-3.9.

a. Use the Line and Trim tools from the Ribbon. Remember, these are the tools
and techniques you mastered in Chapter 5.

b. The 8'-4" line should align with the top riser, in the North-South direction.

DN

ga”

FIGURE 7-3.9
Level 2: Floor boundary at North stair

24. While still in Skezch mode for the Level 2 floor, pan to the right to show the area in
Figure 7-3.10.

You will now define a hole in the floor for ductwork. On a real project, this may be added
later in the project once the mechanical engineer gets involved and suggests the size of
supply and return air ducts needed. You will add the hole now regardless.

25. Select the Pick Walls icon and with Extend into wall (to core) checked, select the shaft
side of the four walls.

a. Use the flip-control arrows for each sketch line if needed because the wrong
side of the wall may have been selected.

b. Use Trim to clean up the corners.
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i e vy

FIGURE 7-3.10 Level 2 (North-East corner): Floor boundary at shaft

Whenever a perimeter is drawn within another, it defines a hole.
Next you will define the floor boundary at the two-story lobby, which starts on Level 1.

26. Sketch the floor opening as shown in Figure 7-3.11:
a. Use the Sp/it tool on the sketch line along the exterior wall.
b. Use the Line tool to sketch the floor opening per the dimensions shown.
c. Use Trim as needed to clean up the corners.

d. You do not have to add the dimensions, but you can if desired. They will be
hidden when the floor is finished.

The last area to define is the curved edge at the curtain wall. On Level 1 the floor went
under the curtain wall; on Level 2 the floor edge needs to be held back from the curtain wall,
allowing room for it to pass by.

27. Using a similar technique as Level 1, sketch the Level 2 floor edge as shown in
Figure 7-3.12.

a. The curved line is 5” in (towatds the interior of the building) in relation to the
adjacent sketch lines.
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3.0

14'- 10"

DN

1

FIGURE 7-3.11 Level 2 (South-East corner): Floor boundary at lobby

FIGURE 7-3.12 Level 2 (South-West cornet):
Floor boundary at curtain wall
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You are now ready to finish the floor sketch and let Revit create the 3D floor object in the
BIM.

28. Click on the Rzbbon to finish the floor sketch.

29. Click Yes to extending the floor below up to the new floor.

[ Revit =5

Would you like walls that go up to this floor's
level to attach to its bottom?

30. Click Yes to join and cut walls.

[ Revit [

The floor/roof overlaps the highlighted wall(s).
Would you like to join geometry and cut the
overlapping volume out of the wall(s)?

31. Select the lobby stair and
use the Move tool to
reposition it as shown in

Figure7-3.13.

FIGURE 7-3.13
Level 2 (lobby area): repositioned stair
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Notice, unlike the Level 1 slab, the LW Concrete on Metal Deck has a surface pattern
defined, which shows up everywhere. You will leave this for now as it helps to see the
extents of the floor in this early design phase of the project.

32. Switch to the Default 3D View.
33. Use the ViewCube to move around the exterior of your building.

Notice you can see the Level 1 and Level 2 floors through the curtain wall glazing!

FIGURE 7-3.14 default 3D view: floors visible through glazing

The image to the right
was generated from
the 3D view above.
Simply select the

floor, click the
sunglasses on the [Zew
Control Bar then select
Isolate Elemsent.

34. Save your
FIGURE 7-3.15 Level 2 floor project.
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Exercise 7-4:
Ceiling Systems

This lesson will explore Revit’s tools for modeling ceilings. This will include drawing
different types of ceiling systems.

Suspended Acoustical Ceiling Tile System:
1. Open your Law Office project.

2. Switch to the Level 1 ceiling plan view, from the Project Browser; ceiling plans are just
below the floor plans.

Notice the doors’ and windows’ visibility are automatically “turned” off in the ceiling plan
views (Figure 7-4.2). Actually, the ceiling plan views have a cutting plane similar to floor
plans, except they look up rather than down.

You can see this setting by right-clicking on a (View Range )
view name in the Project Browser and then —

selecting View Range in the Properties Palette. Tops Offet 00"
The default value is 7'-6". You might increase Cutpane:  [assodatedLevel SecondF | Offiet 76
this if, for example, you had 10"-0" ceilings Bottom:  [sssocated Level(Second ¥ -] Offet
and 8'-0" high doors. Otherwise, the doors "Z:ff’”‘ _ S
would show because the 7'-6" cutting plane

would be below the door height (Figure 7-4.1).

FIGURE 7-4.1 Properties: View Range settings

FIGURE 7-4.2
Level 1 ceiling plan

7-37



Design Integration Using Autodesk Revit 2012

3. Close the open dialog boxes and then select Home => Build > Ceiling.

You have four ceiling types, by default, to select from (Figure 7-4.3).

Modify | Place Ceiling

[ % [ 1 K| E Cepe - Q
Vodity | TR | paste [Slew - - | T 0
P e | w12

L

Select Clipboard Geometry

Properties

Madify | Dlaca Cailing

po— =T Autodack Revit Architachirs 2012 - Not For Racals Varsion - Law Offica |
&

Compound Ceiling
2'x 2" ALI System

Basic Calling
Ge=neic

Compound Ceiling

ulst

7 x Z° ACT System 3@

2 x & ACT System

===5/8" GW3 on Mil. Stud

Most Recertly Used Types
Compound Celing : £ x Z AUI System

:
;

N N ot A . gocndie

FIGURE 7-4.3 Ceiling: Ribbon options

4. Select Compound Ceiling: 2'x2" ACT System.

Next you will change the ceiling height. The Properties

it s m bty ki, iy A g, Ny \Ill_‘u

L-.—-i,.

=

Ceiling

default setting is 10’-0" above the current level.
Compound Ceiling

You will change the ceiling height to 8'-0", this = 2 x 7 ACT System -
will give plenty of space above the ceiling to the
bottom of the joists, perhaps for recessed light Ceilings (1)
tixtures and ductwork. This setting can be CE’“S‘I“"“'S
. P EVEl
changed on a room by room basis. Hence, it is Ficight Gffsst Fram Lo
an instance parameter. Raom Bounding
Dimensions
. o si
5. Ensure the Properties Palette is visible; p;’:r: g
type PP if not. Area
Volume
6. Set the Height Offset From Level setting to H;"m’ Data
omments

8'-0" (Figure 7-4.4). Mark

b o o P

You are now ready to place ceiling grids. This
process cannot get much easier, especially
compared to other CAD programs.

FIGURE 7-4.4 Ceiling: Properties

7. Move your cursor anywhere within the office in the North-West corner of the

building. You should see the perimeter of the room highlighted.

8. Pick within that Northwest room; Revit places a grid in the room (Figure 7-4.5).
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L

2'x2" ACT added

FIGURE 7-4.5: Level 1 Ceiling Plan view: 2'x2" suspended acoustical ceiling tile added to office

You now have a 2'x2" ceiling grid at 8'-0” above the floor, Level 1 in this case. Later in the
book, when you get to the exercise on cutting sections, you will see the ceiling with the

proper height and thickness.

14.

The image to the left is a camera view of the
room you just added the ceiling to. You will
learn how to create camera views in Chapter

Next you will add the same ceiling system to
several other Level 1 rooms.

9. Use the Ceiling tool to place 2'x 2" acoustic ceiling tile (ACT) at 8'-0" above

finished floor (AFF) in the rooms shown (Figure 7-4.0).
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FIGURE 7-4.6: Level 1 Ceiling Plan view: 2'x2" suspended acoustical ceiling tile added to rooms.

When you place a ceiling grid, Revit centers the grid in the room. The general rule of thumb
is you should try to avoid reducing the tile size by more than half of a tile. You can see in
Figure 7-4.6 that the East and West sides are small slivers for the center office on the South
exterior wall. You will adjust this next.

10. Select Modify from the Ribbon.

11. Select the ceiling grid identified in Figure 7-
4.6. Only one line will be highlighted.

12. Use the Move tool to move the grid 12" to

the Fast (Figure 7-4.7).

Moving the grid does not move the ceiling element

itself; only its surface pattern.

Next, you will look at drawing gypsum board ceiling 1 I I

systems. The process is identical to placing the grid

system. FIGURE 7-.4..7 . N .
Level 1 Ceiling plan view: ceiling grid
relocated.
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Gypsum Board Ceiling System:

You will create a new ceiling type for a gypsum board (Gyp. Bd.) ceiling. To better identify
the areas that have a Gyp. Bd. ceiling, you will set the ceiling surface to have a stipple
pattern. This will provide a nice graphical representation for the Gyp. Bd. ceiling areas. The
ceiling you are about to create would lean more towards a commercial application. You will
add this ceiling to toilet rooms; as it holds up better in locations with moisture and provides
better security. The space above a Gyp. Bd. ceiling is not easily accessible as acoustical
ceiling tile (ACT) is, so access panels are often required to access shutoff valves, VAV’s, etc.

The first thing you will do is look at the Revit Materials which are assigned to elements
throughout the model. Materials are used to manage the pattern applied to the surface of an
element seen in elevation, and the pattern applied when an element is cut in section.
Additionally, a color can be selected for Shaded with Edges (Model Graphics Style). Later in
the book, you will also learn how a rendering material can be added, which is used when
creating a photorealistic rendering.

Several elements can reference the same material. For example, a door, trim, a custom
ceiling, furniture, etc., could refer to the same wood material, which could be set to clear
maple. If, at any point in the project, the Material for wood is changed to stained oak, all
elements which reference it are updated. Thus, if several wood finishes or species are
required, you would have to create multiple Materials in Revit.

13. Select Manage => Settings > Matetials. This is the list of materials ﬁ:}
you select from when assigning a material to each layer in a wall system, ete. Materials
14. Select Gypsum Wall Board in the Name list and then
click the Duplicate button and enter the name: Liqﬂ:gs‘ﬂ""“""‘ TN
Gypsum Ceiling Board (see Figure 7-4.8 and Esonry 4

image to right).

15. In the Surface Pattern area, pick the button and
select Gypsum-Plaster from the list, and then
click OK (Figure 7-4.8).

The Surface Pattern setting is what will add the stipple pattern to the Gyp. Bd. ceiling areas.
With this set to none, the ceiling has no pattern, like the basic ceiling type. Creating a new
material allows you to separately control the surface pattern of Gyp. Bd. walls vs. ceilings.
Walls do not have a surface pattern typically, whereas ceilings do.

Thus, if you wanted Carpet 1 finish to never have the stipple hatch pattern, you could

change the surface pattern to none via the Materials dialog and not have to change each view’s
visibility override.
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r N
Materials - Gypsum Ceiling Board [
| Materials | [Identity | Graphics | Structure
| Q
Material Class: [ <all> -
Generic -

GFRC - Glass Fiber Reinforced Concrete
GFRG - Glass Fiber Reinforced Gypsum
Glass

Glass - White, High Luminance Shading

Glazing - Curtain Wall Glazing Use Render Appearance for Shading

Glazing - Window Glazing

o g e E

Gypsum Wal Bcard Click here to select

Insulation / Thermal Barriers - Batt insula RGS 127-127-127

Insulation / Thermal Barriers -E1FS -]~ PAttern ransparency: | 0% | [———————————
Insulation / Thermal Barriers - Reflective|
Insulation / Thermal Barriers - Rigid insulation U Surface Pattern
Insulation / Thermal Barriers - Semi-rigid insulation

Laminate - Ivory, Matte
Liquid

Masonry Gypsum-Plaster Black
Masonry - Brick
Masonry - Brick Soldier Course Texture Alignment...

Masonry - Concrete Masonry Units
Masonry - Concrete Masonry Units - Split Face CutPattern

Masonry - Glass Block —— ]

Masenry - Tile

Metal Duplicate material Sand Black
ome| Dutton

Metal

5
a
4

=) e [

& o

FIGURE 7-4.8 Materials dialog

The template you started from does have one Gyp. Bd. Ceiling, but this is meant for a soffit
or a small room where the ceiling is not suspended from the structure above; it has 3%s"
metal studs. You will use this ceiling as a starting point, and create a ceiling with %" metal

furring over 172" metal studs/channels. All of this is then suspended by wites from the
structure above; these wires are not modeled in Revit.

16. From the Home tab on the Ribbon, select Ceiling.

17. Set the Type Selector to 5/8" GWB on Metal Stud.

FYI: You are selecting this because it is most similar to the ceiling you will be creating.

GWB = Gypsum Wall Board
18. Click the Edit Type button.
19. Click Duplicate and type the name Susp GB on Metal Stud.

At this point you have a new ceiling type available to be placed in the model. However, it is
exactly like the one you copied (i.e., 7" GWB on Metal Stud). Next, you will modify the
composition of your new ceiling type system family.
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20. Select Edit next to the S#ucture parameter.

21. Create a Layer and set the values as follows (Figure 7-4.9):
a. 1%" Mtl. Stud

b. %" Mtl. Stud
c. Gypsum Ceiling Board
(Lhis is the material you created in Step 13.)

T1P: Use the Insert button to add a new Layer and then, with the new Layer selected, use the up
and down buttons to reposition the Layer within the ceiling system.

22. Click OK two times to close Edit Assembly =5
the Open dlalog bOXCS' Family: Compound Ceiling
Type: Susp GB on Metal Stud
Total thickness: o' 278"

FYI: The ceiling assembly you just
created represents a typical suspended
GJP Bd L‘gl/]ﬂg Systens. The Metal Function Material Thickness | Wraps | =

Layers

Studs are perpendicular to each other 1 |Core Boundar LayersAboveWrap .00 =
. L. 2 | Structure [1 Metal - Stud Layer 0 1172"
and suspended by wires, similar to 3 | Structure {1 Metal - Stud Layer LT
an ACT system. 1 | Core Boundar | Layers Below Wrap 00"
5 | Finish 2 [5] Gypsum Ceiling Board  i0' 05/8"

You are now ready to draw a

gypsum board ceiling. e o Dow

23. Make sure Susp GB on
Metal Stud is selected in the
Type Selector on the Properties
Palette.

’ << Preview ] [ 0K J[ Cancel ” Help

24. Set the ceiling height to 8'-
”
0" FIGURE 7-4.9 New ceiling — edit assembly

25. Pick the two toilet rooms as shown in Figure 7-4.10.
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MECH. ROOM

FIGURE 7-4.10 Gyp. Bd. Ceiling

You now have a gypsum board ceiling at 8'-0" above the Level 1 floor slab. Notice the
stipple pattern does a good job of highlighting the extents of the Gyp. Bd. Ceiling, as
compared to the adjacent mechanical room which will not have a ceiling.

DESIGN INTEGRATION T1P: Once the structure and HV AC (i.e., ductwork) have been
added, any ceilings will obscure those elements if they are lower in elevation. However, all those
elements will show in the mechanical room. Showing the structure and HV AC is great for
coordination and helps the contractor understand the project better. For instance, how difficnlt would
it be to paint the Mechanical Room structure and ductwork.

Adding a Bulkhead:
Next, you will place a ceiling in the hallway. 212" VETAL STUDS
However, you cannot simply pick the room to / AT 1670,
place the ceiling because Revit would fill in the Pulkhead example Lo 1 / g el e
adjacent lobby and office area. First, you will "
need to draw bulkheads to close these areas off ; /.~ SEERM FINISH SCHED
at the ceiling level. They will not be visible in v ~—11Y|

. [T LIGHT FIXTURE
the floor plan view as they do not pass through . &

"~ 5/8" GYPSUM BOARD, TYP.

its cut plane. A bulkhead is a portion of wall
that hangs from the floor or structure above

(see image to right) and creates a closed \ TE PLaCTC
perimeter for a ceiling system to abut into. The = EGG—CRATE LENS
bulkhead will create a perimeter that the Ceiling D—
tool will detect for the proper ceiling

placement.

WALL

26. While still in the Level 1 ceiling plan view, select the Wall 70/
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Properties [=] 27.
Basic Wall -
Intenior - 4 7/8" Partition (1-hr)
28.
New Walls v] Edit Type
Constraints 2 .
Location Line Wall Centerline
Base Constraint Level 1
Base Offset 7' 10"
Basze is Attached 1 29.
Base Extension Distance 0o

Top Constraint

Up to level: Level 2

Unconnected Height

T

Top Offset oo
Top is Attached ]
Top Extension Distance oo
Room Bounding 1
Related to Mass 1

Structural
Structural Usage

MNon-bearing

»

Dimensions
Area

»»

Yolume

Identity Data
Comments

»

Pow

Properties help

Apply

FIGURE 7-4.11 Bulkhead (wall) properties

30.

In the Type Selector, set the wall type to:
Interior — 4 7/8" Partition (1-hr)

In the Properties Palette, set and the Base
Offset to 1'-10". This will put the bottom of the

wall to 710" above the current floor level, 1 evel
1 in this case (Figure 7-4.12).

Set the Top Constraint to: Up to level:
Level 2 (Figure 7-4.11).

TIP: The next time you draw a wall, you will have
to change the Base Offset back to 00" or your wall
will be 710" off the floor; this is hard to remember!

Draw the bulkhead; make sure you snap
to the adjacent walls (Figure 7-4.12).

FIGURE 7-4.12 Bulkhead modeled
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31. Select the Ceiling tool and hover your cursor over the hallway.

Notice, in Figure 7-4.13, how the bulkheads create a valid perimeter in the hallway. If the

bulkhead bottom was 8'-2" or the ceiling height were 7'-8", Revit would not find this same
perimeter. Take a moment and give it a try. Undo any changes before moving on.

FIGURE 7-4.13 Ceiling perimeter highlighted

32. With the ceiling height set to 8'-0", click in the hallway to place the 2'x2" ACT
System.

33. Reposition the grid as shown in Figure 7-4.14.

a. Sometimes, with odd shaped rooms like this, it can be impossible not to have
small slivers of tiles.

FIGURE 7-4.14 Hallway ceiling placed

DESIGN INTEGRATION TIP: In addition to laying out the ceiling tile to minimize sliver tiles,
the grid needs to accommuodate the lighting design. In the ballway, a full tile is provided down the
center with this in mind.
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34. Place the remaining bulkheads and 2'x2" ACT ceilings per the image below; note the
ceiling and bulkhead heights vary (Figure 7-4.15).

35. Use the Align tool to make adjacent ceiling grids line up as shown; remember, select
the item you do not want to move first.

S RENREE i
qu.

Bulkhead at 7'-10" '
A A o | A Al

[ [T ]

.

Bulkhead at 9'-0" —
follow floor edge

S A

FIGURE 7-4.15 Remaining Level 1 ceilings and bulkheads

You are now ready to move on to the Level 2
reflected ceiling plan. First, you need to create a view
in which to work.

Deleting a Ceiling Grid:

When selecting a ceiling grid, Revit |
only selects one line. This does not i
allow you to delete the ceiling grid. !
To delete: hover cursor over a i

36. Select View => Create > Plan Views =
Reflected Ceiling Plan.

ceiling grid line and press the Tab

key until you see the ceiling

perimeter highlight, then click the

mouse. The entire ceiling will be

selected. Press Delete.

37. Do the following:

a. Select Level 2.

b. Set the scale to 1/4" =1'-0"

38. Click OK.

You now have a Level 2 ceiling plan view in which to work. It is possible to make multiple
plan or ceiling views of the same level (e.g., floor plan, finish plan, code plan, etc.)
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39. Using the techniques previously covered, add the Level 2 ceilings per the
information provided in Figure 7-4.16.

a. Rotated ceiling:
1. Select a grid line.
ii. Use the Rotate tool.
iii. Move the grid as shown.

b. Bulkhead:
i. Bottom at 8'-0"
ii. Draw with Arc tool or Pick with offset.
ili. Show approx. 3'-0" from exterior wall.

o™ 8- | -850

[

FIGURE 7-4.16 Level 2 ceilings and bulkhead

40. Save your project.
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Self-Exam:

The following questions can be used as a way to check your knowledge of this lesson. The answers
can be found at the bottom of the page.

1.

2.

You don’t have to click Finish Roof when you are done defining a roof. (T/F)

The wall below the roof automatically conforms to the underside of the roof when
you join the walls to the roof. (T /F)

The roof overhang setting is available from the Options Bar. (T/F)

To create a gable roof on a building with 4 walls, two of the walls should not

have the option checked.

Is it possible to change the reference point for a temporary dimension that is
displayed while an object is selected? (Y/N)

Review Questions:
The following questions may be assigned by your instructor as a way to assess your knowledge of this
section. Your instructor has the answers to the review questions.

1.

10.

When creating a roof using the “create roof by footprint’ option, you need to create a
closed perimeter. (T/F)

The Defines slope setting can be changed after the roof is “finished.” (T/F)
The ceiling grid position cannot be modified. (T/F)
To delete a ceiling grid, you must first select the perimeter. (T/F)

While using the Rooftool, you can use the tool from the Ribbon to
fill in the missing segments to close the perimeter.

You use the variable to adjust the vertical position of the roof relative
to the current working plane (view).

Tool used to draw a bulkhead:

You need to use the to flip the roofline when you pick the
wrong side of the wall and the overhang is shown on the inside.

A second, internal, perimeter creates a hole in the floot. (T/F)
Changing the name of a level tag (in elevation) causes Revit to rename all the

corresponding views (plan, ceiling, etc.) if you answer yes to the prompt. (T/F)

SELF-EXAM ANSWERS:
1-F,2-T,3-T, 4 - defines slope, 5 - Y
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